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Document History

A Caution

Before you start the implementation, make sure you have the latest version of this document. You can find
the latest version at the following location: http://help.sap.com/ewm.

The following table provides an overview of the most important document changes.

Version Date Description

14 2019-10-17 Chapter Data Growth and Data
Archiving Monitors updated for SAP Ex-
tended Warehouse Management 9.5

SPO5

13 2018-10-10 Chapter Interface Monitors updated for
SAP Extended Warehouse Management
9.5 SP03

1.2 2018-04-04 Chapters Data Growth and Data

Archiving Monitors and Scheduled
Periodic Tasks updated for SAP Ex-
tended Warehouse Management 9.5
FPO2

11 2018-01-17 Updated with integration details for
SAP Global Batch Traceability

10 2017-11-30 Initial version of the Application Opera-
tions Guide for SAP Extended Ware-
house Management 9.5
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1 Getting Started

A Caution

This guide does not replace the daily operations handbook that we recommend customers create for their
specific production operations.

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never
been more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement
them. This guide also provides references to the documentation required for these tasks, so you need other
guides such as the Master Guide, Technical Infrastructure Guide, and SAP Library.

11 Global Definitions

SAP Application:

An SAP application is an SAP software solution that serves a specific business area such as ERP, CRM, PLM,
SRM, or SCM.

Business Scenario:

From a microeconomic perspective, a business scenario is a cycle that consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves other business partners. From a technical point of view, a business scenario needs at least one
SAP application (SAP ERP, SAP SCM, and so on) for each cycle and possibly other third-party systems. A
business scenario is a unit that can be implemented separately and reflects the customer’s prospective course
of business.

Component:

A component is the smallest individual unit considered within the Solution Development Lifecycle; components
are separately produced, delivered, installed, and maintained.
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1.2 Important SAP Notes

A Caution

Check regularly to see which SAP Notes are available for the Application Operations Guide.

Important SAP Notes

SAP Note Number

Title

Comment

1515223 SAP NetWeaver Process Integration: Information about which Pl release to
Release Recommendation use
1721448 P Service Connection "SAPGui+Browser  Remote log on for SAP Support
Connect"
812732¢% R/3 Support Service Connection Remote log on for SAP Support when
all affected Uls are based on SAP GUI
14230664 Optimization of the Performance in
EWM
2163060M% Prerequisites and Restrictions of Zero
Downtime Option of SUM
2293063 Restrictions of ZDO Upgrade for SAP
EWM by SCM Basis
2251678 Restrictions for ZDO Upgrade for SAP
EWM
2232718 ¥ Business Application Restrictions Dur-

ing ZDO Upgrade in EWM: LDP

1.3 Dock Appointment Scheduling

If you are using SAP Dock Appointment Scheduling without integration with SAP EWM, you need only refer to
the following sections of this document:

® Scheduled Periodic Tasks [page 22]
e Required Manual Periodic Tasks [page 28]

® Problem Message Handover [page 34]
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2 Technical System Landscape

2.1 Scenario/Component Matrix

For more information about the components necessary for business scenarios and processes, see the SAP
Extended Warehouse Management (SAP EWM) Master Guide at http://help.sap.com/ewm.

2.2 Related Documentation

i Note

This Application Operations Guide only covers SAP EWM. If you run SAP EWM as part of an SAP SCM
Server installation, use the Application Operations Guide at http://help.sap.com/scm.

You can find more information about the technical system landscape as follows:

e Seethe SAP EWM Master Guide at http://help.sap.com/ewm for the following information:
o Application-specific and industry-specific components such as SAP for Automotive or SAP Retail
o Technology components such as SAP NetWeaver
o Technical configuration
o Scalability
o High availability
e See information about the Quick Sizer Tool at http:/www.sap.com/about/benchmark/sizing.quick-
sizer.html| ¥ .
e See operations information for SAP NetWeaver at http://help.sap.com/nw.

For more information, see SAP Solution Manager at http://help.sap.com/ewm. The following documents
provide additional information for the system setup and monitoring:

Guide Navigation Path

Integration of SAP ERP with SAP EWM |+ Solution Manager for Implementation 4

Integration of SAP Transportation Management with SAP |} Solution Manager for Integration with Transportation
EWM (multiple guides available) Management 4

SAP Extended Warehouse Management 9.5 Operations Guide
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3 Monitoring of SAP EWM

Within the management of SAP technology, monitoring is an essential task. A section has therefore been
devoted solely to this subject.

You can find more information about the underlying technology in SAP NetWeaver at http://help.sap.com/nw
& under | Technical Operations for SAP NetWeaver 1.

3.1 Alert Monitoring

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system
environment. SAP provides you with the infrastructure and recommendations needed to set up your alert
monitoring to recognize critical situations for SAP Extended Warehouse Management (SAP EWM) as quickly as
possible.

3.1.1 Monitoring Installation and Setup

To enable the auto-alert mechanism of CCMS, see SAP Note 617547 F& .

You can find the SAP EWM-relevant CCMS monitor sets in the SAP EWM system in transaction CCMS Monitor
Sets (Rz20). Choose |r CCMS Monitor Sets  SAP EWM Monitor Templates 3.

3.1.2 SAP EWM-Specific Monitoring

SAP EWM provides the warehouse monitor as a central place to monitor your business processes from the
business and the technical perspective. You can start the monitor on the SAP Easy Access screen by choosing

| SCM Extended Warehouse Management » Extended Warehouse Management » Monitoring » Warehouse

Management Monitor J (transaction /scwM/MON). The following chapter will give you more detailed
information.

SAP Extended Warehouse Management 9.5 Operations Guide
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3.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

You can find more information about the underlying technology for SAP NetWeaver at http://help.sap.com/nw
#% under | SAP NetWeaver Platform # Technical Operations for SAP NetWeaver 3 and under |+ SAP Process
Integration » SAP NetWeaver Process Integration 3.

3.2.1 Trace and Log Files

Trace files and log files are essential for analyzing problems.

The standard SAP NetWeaver tools such as transactions sT22 and sM21 can be used to monitor trace and log
files. For more information, see SAP NetWeaver at http://help.sap.com/nw# under | Technical Operations for
SAP NetWeaver » Administration of Application Server ABAP » Monitoring and Administration Tools for
Application Server ABAP 1.

Additionally, SAP EWM uses the application log (part of SAP NetWeaver) to store application error, warning,
and success messages issued in critical processes (for example, the delivery interface between SAP ERP and
SAP EWM) or in Ul transactions. For Ul transactions, the user must save the application log explicitly.

For general information on application logs, see SAP NetWeaver at http:/help.sap.com/nw#& under

|\ Function-Oriented View # Solution Life Cycle Management ¥ Application Log — (BC-SRV-BAL) 1.

You can monitor the application logs with transaction SL.G1 or in the warehouse management monitor under
|+ Tools » Application Log 3.

Log Object Detailed Description Activation/Deactivation

/SCWM/DLV_ERP Delivery Processing: Stores error mes-  The system saves the log automatically
sages issued during the gRFC commu-  when the gRFC fails. If you need a log
nication of deliveries between SAP ERP  for messages that were processed
and SAP EWM with an expiry time of without error for test purposes, you can
seven days. change the settings in transaction /

SCWM/ERPLOG (|# SAP Easy Access
> Extended Warehouse Management >
Settings > Configure Log for ERP
Messages }).

SAP Extended Warehouse Management 9.5 Operations Guide
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Log Object

Detailed Description

Activation/Deactivation

/SCWM/ACC

Log for import of accounting objects
from SAP ERP

Log must be saved explicitly in transac-

tion /scwm/acc_1Mp ERP (B SAP
Easy Access: Extended Warehouse

Management > Interfaces > ERP
Integration  Administration of Account

Assignment Data ]).

/SCMB/PATTERN UI

Log for Ul messages

Log must be saved explicitly in the SAP
EWM Ul transactions.

/ SCWM/WME

Warehouse Logistics Processing: Log
for SAP EWM operations

Log must be activated with transac-

tion /scum/acTLoG ([ SAP Easy

Access: Extended Warehouse
Management > Settings > Activate
Application Log ]).

You can activate the application log on
subobject level.

/SCWM/SHP_RCV

Site Logistic Processing: Log for ship-
ping and receiving transactions

/SCWM/EPD

Labor Management: Log for sending
performance documents to HR

Log must be saved explicitly by the
user in transaction /scwM/

EPD_TRANSFER (|} SAP Easy Access:
Extended Warehouse Management p
Labor Management > Employee
Performance > Send Performance

Document to HR 3).

/SCMB/MD

Master Data: Log for deleting supply
chain units

/SCWM/PACKSPEC

Master Data: Log for packaging specifi-
cations

The log for the determination analysis
must be activated in transaction /
SCWM/PSLOG. The log for uploading
packaging specifications must be
saved explicitly by the user in transac-

tion /scum/1pU (| SAP Easy Access:
SCM Basis > Master Data > Packaging
Specification ¥ Initial Data Transfer of

Packaging Specifications 3
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Log Object Detailed Description Activation/Deactivation
/SEHS/ALE EH&S Master Data: log for importing
master data (dangerous goods, hazard-
ous substances and phrases)
/SCTM/TM Transportation Management
PPF Post Processing Framework The log is always active. You can deacti-
vate the log for delivery processing in
transaction /SCWM/DLVPPFLOG
(|} SAP Easy Access: Extended
Warehouse Management > Delivery
Processing > Actions > Deactivate PPF
Log Depending on Warehouse and
User 3.
/SCMB/RG Routing Guide
/SCWM/CHM EWM Check Monitor
/SCWM/DAS Dock Appointment Scheduling The log is used for asynchronous proc-

esses and reports in Dock Appointment
Scheduling. By default, the log is writ-
ten for errors and warnings.

You can change the activation of the log
in transaction /SCWM/DSLOG.

During the implementation and test phase, or when you need to investigate an issue, you should activate the
related logs. Once the system is running smoothly, you can improve the performance if you configure the logs
to record only Important or Very Important messages or deactivate them completely.

For descriptions of the recommended tasks to contain data growth, see Periodic Tasks [page 22].

3.2.2 Workload Monitors

SAP EWM uses the standard tools available in SAP NetWeaver and does not require a component-specific tool.

For more information, see SAP NetWeaver at http://help.sap.com/nw# under | Technical Operations for SAP

NetWeaver 3.
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3.2.3 Other Important Problem Analysis and Monitoring

SAP EWM uses the standard tools available in SAP NetWeaver and does not require a component-specific tool.

For more information, see SAP NetWeaver at http://help.sap.com/nw# under | Technical Operations for SAP

NetWeaver 3.

3.2.4 Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP.

Interface

Description Technology Used

Delivery Processing

SAP ERP and SAP EWM gRFC

Communication based on ERP deliver-
ies/SAP EWM warehouse requests as
foundation for logistics execution in
SAP EWM

Relevant for all systems with integration
to SAP ERP

Goods Movement

SAP ERP and SAP EWM gRFC

Goods movements that are not directly
related to an SAP ERP delivery docu-
ment

Relevant for all systems with integration
to SAP ERP

Distribution of Master Data

SAP ERP and SAP EWM gRFC

Relevant for all systems with integration

to SAP ERP
Bl Data Sources SAP BW and SAP EWM Not applicable
Transportation Integration (SAP ERP) SAP ERP and SAP EWM IDoc

Communication based on SAP ERP
shipment (including SAP ERP Shipment
created by SAP TM)/SAP EWM trans-
portation unit

Optional business process

12
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Interface

Description

Technology Used

Transportation Integration (SAP TM)

SAP ERP and SAP TM
Web Services

Optional business process

XI + web service

Warehouse Billing

SAP TM
Web Services

Optional business process

XI + web service

Quality Inspection SAP ERP and SAP EWM gRFC
Integration of quality inspection in SAP
ERP and SAP EWM
Optional business process

Global Trade Compliance Check SAP Global Trade Services and SAP RFC, qRFC

EWM

Optional business process

Material Flow System

Not applicable

Not applicable

Yard Management

Web Services for Non-SAP systems

Optional interface

XI + web service

Delivery Notifications

Web Services for Non-SAP systems

Optional interface

XI + web service

Transportation Integration with External
Planning System

Integration with Non-SAP systems

Optional interface

IDoc

Global Batch Traceability Integration
(SAP Global Batch Traceability)

SAP Global Batch Traceability and SAP
EWM communication based on events
created in SAP EWM

XI + web service

SAP Extended Warehouse Management 9.5 Operations Guide
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Monitor tools for these interfaces are:

Interface Monitor Description Prerequisites
Delivery Processing SMQ1/SMQ2 Standard gRFC monitoring Create settings for qRFC
as described in the applica-  scheduling and administra-
tion help for SAP NetWeaver  tionin transactions SMQE,
SMQS and SMQR as d i-
Queues beginning with DLVS, 5 dQ' tahn nt Q :S ;S_CCT
DLWS ed in the Integration Guide.
The queue on the SAP ERP
side should be monitored
within one month as a goods
movement can only be
posted in the current and
previous period (for example,
a goods movement sent to
the queue on July 15 must be
posted on August 31 at the
latest).
Goods Movement SMQ1/SMQ2 Standard gRFC monitoring Create settings for gRFC
as described in the applica-  scheduling and administra-
tion help for SAP NetWeaver tion in transactions SMQE,
SMQS and SMQR as d i-
Queues beginning with EWM- 5 dQ' tahn nt Q t_as gs-c(:
GOODSMVT WMPGR. ed in the Integration Guide.
WMPGI For the monitoring of
queues in SAP ERP, see De-
livery Processing above.
Production (Production Ma- ~ SMQ1/SMQ2 Standard gRFC monitoring Create settings for gRFC
terial Request) as described inthe applica-  scheduling and administra-
tion help for SAP NetWeaver tion in transactions SMQE,
SMQS and SMQR as d i-
Queues beginning with PR QSan QR as descri
bed in the Integration Guide
(see Related Documentation
[page 7]).
Distribution of Master Data SMQ1/SMQ2 Standard gRFC monitoring Create settings for gRFC

as described in the applica-
tion help for SAP NetWeaver

Queues beginning with CF,
PS, CS4, and EWMDRFINI-
TIALLOAD

scheduling and administra-
tion in transactions SMQE,
SMQS and SMQR as descri-
bed in the Integration Guide.

14 PUBLIC
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Interface

Monitor

Description

Prerequisites

Bl Data Sources

SMQ1/SMQ2

Standard gRFC monitoring
as described in the applica-
tion help for SAP NetWeaver

Queues beginning with
WMBB, WMDB, WMTB,
WMOB, WMVB

Transportation Integration
(SAP ERP)

WEINQUEUE/WEOUTQUEUE

Standard IDoc monitoring as
described in the application
help for SAP NetWeaver

IDocs SHPMTO5, SHPMTO6

Transportation Integration
(SAPTM)

SXMB_MONI

Standard XI monitoring as
described in the application
help for SAP NetWeaver

Warehouse Billing

SXMB MONI

Standard XI monitoring as
described in the application
help for SAP NetWeaver

Quality Inspection

SMQ1/SMQ2

SWEQADM, SWETYPV,
SWELS

Standard gRFC monitoring
as described in the applica-
tion help for SAP NetWeaver

Queues beginning with
QI,DLVS, DLWS, and
EWMSQPO

Create settings for gRFC
scheduling and administra-
tion in transactions SMQE,

SMQS and SMQR as descri-
bed in the Integration Guide

Material Flow System

/SCWM/MON, node |# Material

Flow System p Telegram

Communication between
SAP EWM and PLC

Buffer }

Yard Management SXMB MONTI Standard XI monitoring as
described in the application
help for SAP NetWeaver

Delivery Notifications SXMB MONI Standard XI monitoring as
described in the application
help for SAP NetWeaver

Transportation Integration WEINQUEUE/WEOUTQUEUE Standard IDoc monitoring as

with External Planning Sys-
tem

described in the application
help for SAP NetWeaver

IDocs TMSHPO1, TMFRD2

SAP Extended Warehouse Management 9.5 Operations Guide
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Interface Monitor Description Prerequisites

Global Batch Traceability In-  SXMB_MONT Standard XI monitoring as
tegration (SAP Global Batch described in the application
Traceability) help for SAP NetWeaver

- Recommendation

As an alternative to the technical monitoring, you can monitor the gqRFC messages between SAP EWM and
SAP ERP in a business context. In the SAP EWM monitor (transaction /scwM/MON) under node [¢ Tools
Message Queue 1 you can get a list of SAP EWM-relevant queues in the SAP EWM and SAP ERP systems.
The system enriches the list with relevant information for a business user such as the warehouse number

and texts. You can use this additional option for monitoring queues without additional configuration, but
you can also adapt the selection to the needs of your users in Customizing for Extended Warehouse

Management under |+ Monitoring  Warehouse Management Monitor » Message Queue Monitoring 3.

From SAP EWM 9.1 and higher, you can configure e-mail and SMS alerts for failed queues. Therefore, you
do not need to monitor the queues actively. For more information, see SAP EWM at http://

help.sap.com/ewm#& under |+ Monitoring ¥ Warehouse Management Monitor ¥ Message Queue
Monitor 3.

SAP EWM uses the gRFC for internal messages to achieve minimal response time for users who need to
work with a high throughput. These queues also need to be monitored. You can do the monitoring as
described for the interfaces above, using transaction sMQ2/sMQ1 for queues starting with wM, EwWM, or DLV.
Alternatively, you can use the SAP EWM monitor to display the queues with additional business data as
described above.

3.2.5 Data Growth and Data Archiving Monitors

SAP EWM uses the standard tools available in SAP NetWeaver and does not require a component-specific tool.
For more information, see operations information for SAP NetWeaver at http://help.sap.com/nw.

You can archive the following data in SAP EWM:

Application Component Business Object/Document Archiving Object Re-Schedule Report After
Category Upgrade to EWM 9.5*%
Delivery Processing Internal Warehouse Requests DLV _INB X

(Inbound Delivery)

Internal Warehouse Requests DLV_OUT X
(Outbound Delivery)

Warehouse Requests from DLV _REQ X
External Systems

16
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Application Component Business Object/Document Archiving Object Re-Schedule Report After

Category Upgrade to EWM 9.5*
Stock Management Handling Unit WME_HU
Warehouse Logistic Process- Warehouse Tasks and Goods WME_TO X
ing Movement Documents

Warehouse Orders WME_WO X

Waves WME_WAVE X

Telegram Flows WME MF'S X

Relevant Resource Data WME RSRC X

Value-Added Service Orders ~ WME_VAS X

(VAS Orders)

QIE Inspection Documents QIE_INSP

Physical Inventory Docu- LIME PI
ments
LIME Log Entries (goods LIME NLOG

movements and confirmed
warehouse tasks). Periodicity
analogous to WME_TO

Site Logistic Processing Door Activities WME_DOOR X
Vehicle Activities WME _VEH X
Transport Unit Activities WME_TU X

Labor Management Indirect Labor Tasks WME ILT X
Executed Workloads WME_EWL X
Employee Performance WME EPD X
Documents

Business Partners (Process- CA_BUPA
ors) — only if created origi-
nally in SAP EWM

SAP Extended Warehouse Management 9.5 Operations Guide
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Application Component

Business Object/Document Archiving Object
Category

Re-Schedule Report After
Upgrade to EWM 9.5*

Change Documents (for Em- CHANGEDOCU
ployee Performance Docu-

ments and Time & Attend-

ance entries that were de-

leted manually) can be ar-

chived or deleted. Selection

criteria: object classes /

ScwM/EPD and /SCWM/TATT.

Transportation Management = Shipments TM SHP
in EWM
Freight Documents TM_FRD
Express Shipping Interface Manifest EWM ESI MF
Parcel EWM_ESI_PA
Warehouse Billing EWM Warehouse Billing EWM WBM
Measurements
Shipping and Receiving Change Documents (for CHANGEDOCU

Transportation Units, Trans-
portation Unit Assignments,
and Vehicles) can be archived
or deleted. Selection criteria:
object classes /scwM/TU, /
SCWM/TUDLV, and /SCWM/
VEH.

A Caution

The archiving reports for the archiving objects marked with * were improved in SAP EWM 9.3. After an
upgrade from SAP EWM 9.2 or lower to SAP EWM 9.5 you must adapt your existing background jobs for
those archiving objects with new variants.

The affected archiving object reports are the following:

Archiving Object Report
WME TO WME ARCH TO WRITE
WME WO WME ARCH WO WRITE
WME_WAVE WME_ARCH WAVE WRITE
WME_MF'S WME ARCH MFS DELETE
SAP Extended Warehouse Management 9.5 Operations Guide
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Archiving Object

Report

WME ARCH MFS WRITE

WME_RSRC WME_ARCH RSRC_WRITE
WME TU WME ARCH TU MARK
WME ARCH TU WRITE
WME VEH WME ARCH VEH MARK
WME_ARCH VEH WRITE
WME_DOOR WME_ARCH DOOR MARK
WME_ARCH DOOR WRITE
DLV_INB /SCDL/DLV_INB_ARCH WRITE
DLV_OUT /SCDL/DLV_OUT ARCH WRITE
DLV_REQ /SCDL/DLV_REQ ARCH WRITE
WME_VAS WME_ARCH_VAS_WRITE
WME_EPD /SCWM/EPD_ARCH WRITE
WME_EWL /SCWM/EWL_ARCH WRITE
WME ILT WME ARCH ILT WRITE
i Note

Replicated master data (for example, products, locations, supply chain units, business partners, and batch

data) does not have to be archived in SAP EWM. Master data is deleted by the solution in which it was
originally created, for example, SAP ERP or SAP Customer Relationship Management (SAP CRM).

A Caution

SAP EWM also creates data that is not subject to archiving. Make sure to schedule periodic deletion jobs as
described in Periodic Tasks [page 22], to control data growth and to ensure the performance of your SAP

EWM system.

3.3 Data Consistency

SAP EWM exchanges data with SAP ERP using asynchronous messages. Monitor the gqRFC messages in the
SAP EWM system and in the SAP ERP system as described in Interface Monitors [page 12].
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You can check the consistency of your SAP EWM system using transaction /scwM/cHM PRF (Maintain Check
Monitor Profile). The particular checks are documented in the transaction.
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4 Management of SAP EWM

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and
operation.

For more information on the underlying technology, see SAP NetWeaver at http://help.sap.com/nw#& under
|» Technical Operations for SAP NetWeaver .

4.1 Starting and Stopping

SAP Extended Warehouse Management (SAP EWM) is provided either as a standalone component on SAP
NetWeaver, as part of SAP SCM, or as an add-on to SAP ERP.

e SAP EWM as a standalone component on SAP NetWeaver is started/stopped together with SAP
NetWeaver. For more information about STARTSAP/STOPSAP and SAPMMC, see SAP NetWeaver at http://
help.sap.com/nw# under |p Function-Oriented View » Solution Life Cycle Management » Starting and
Stopping SAP Systems Based on SAP NetWeaver .

e SAP EWM as part of SAP SCM: SAP EWM is started/stopped together with the SCM Server (STARTSAP/
STOPSAP). For more information, see the Application Operations Guide at http://help.sap.com/scm.

e SAP EWM as an add-on to SAP ERP: SAP EWM is started/stopped together with SAP ERP (STARTSAP/
STOPSAP). For more information, see the Application Operations Guide at http://help.sap.com/erp.

In all cases, we recommend that you start the interface components CIF and SAP Xl (if used) after starting SAP
EWM and that you stop them before stopping SAP EWM.

For more information about the components necessary for business scenarios and processes, see the SAP
EWM Master Guide at http://help.sap.com/ewm.

4.2 Software Configuration

This section explains which components or scenarios used by this application are configurable and which tools
are available for adjusting.

All technical configuration that is required for running SAP EWM is part of SAP NetWeaver. For information
about the relevant technical configuration, see SAP NetWeaver at http://help.sap.com/nw# under

|+ Function-Oriented View » Solution Life Cycle Management » SAP NetWeaver Configuration 3.
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4.3 Administration Tools

SAP EWM and the underlying components are all technically based on SAP NetWeaver. For information about
the relevant administration tools, see SAP NetWeaver at http://help.sap.com/nw# under | Technical
Operations for SAP NetWeaver 3.

4.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure.

The backup and restore strategy for the application consists of the following:

e Backup and restore coverage for each component
e (Cross-system data dependencies and handling

The backup and restore strategy for your system landscape must not only consider SAP systems but must also
be embedded in the overall business requirements and incorporate your company'’s entire process flow. In
addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data
center through fire. In this context, it is essential that you ensure that backup devices are not lost together with
normal data storage, by using separate storage locations.

SAP EWM 9.5 is based on SAP NetWeaver technology. All related SAP NetWeaver backup procedures also work
for SAP EWM. Therefore, there is no special procedure for SAP EWM 9.5. For more information on backup and
recovery, see operations information for SAP NetWeaver athttp://help.sap.com/nw# . If you need to recover
your system you can check the consistency with the SAP ERP system after the recovery as described in Data
Consistency [page 19].

4.5 Periodic Tasks

In addition to the standard jobs mentioned in Technical Operations for SAP NetWeaver in SAP Library, you must
schedule SAP EWM-specific jobs in your SAP system.

All jobs, unless otherwise specified, must be run at times of minimal system activity, so as not to affect
performance or otherwise disrupt your daily operations. All jobs can be restarted.

4.5.1 Scheduled Periodic Tasks

This section describes all tasks that can be automated and that must be run periodically to keep the
application running smoothly. Such tasks may be required on component level and are, therefore, relevant in
each scenario that uses the component. Other tasks may be relevant for certain business scenarios only. It is
important that you monitor the successful execution of these tasks on a regular basis.
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For more information about the components necessary for business scenarios and processes, see the SAP
EWM Master Guide at http://help.sap.com/ewm.

Scheduled Periodic Tasks for SAP EWM

Program Name/Task

Task Scheduling Tool

Recommended Frequency

Detailed Description

Transaction SARA

Transaction SARA and Depends on the archiving object

Definition of Back-
ground Jobs

and the DB growth

Archives archiving objects men-
tioned in Data Growth and Data Ar-
chiving Monitors [page 16]

A Caution

After the upgrade to EWM 9.5,
the jobs that you scheduled be-
fore the upgrade will not work
anymore. You must schedule
them again. For further informa-
tion see Data Growth and Data
Archiving Monitors [page 16].

Transaction sSLG2 (re-  Definition of Back- Weekly or monthly Deletes application logs described
port SBAL DELETE) ground Jobs in Trace and Log Files [page 9]
Report Definition of Back- Weekly or monthly Deletes technical data from PPF ac-

RSPPF_SWJCLEAN

ground Jobs

tions. See note 1890845 F .

Report /scwM/
PI_PERS PPF DEL

Not applicable

Periodicity analogous to archiving
periods of the physical inventory
documents

Warehouse logistics processing: De-
letes SAP EWM-specific PPF action
data

Report /LIME/
COLLECTION DELETE

Not applicable

Periodicity analogous to archiving
periods of the confirmed warehouse
tasks

Warehouse logistics processing: De-
letes the dispatch message log for
goods movements between SAP
EWM and SAP ERP.

® Planning System

® Business Warehouse

® Financial System

® |nventory System

e [xternal System

® R/3Inventory Mngmt

o Gl W2IM:X

e Minimum Age in Days

e End Date of Deletion Run:
fill in actual date

All processed records will be deleted
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Program Name/Task Task Scheduling Tool

Recommended Frequency

Detailed Description

Report /LIME/
BACKGROUND
DELETE EXEC

Not applicable

Weekly or monthly

To delete zero quantities, set no
other parameter

Inventory: Deletes DB entries for
zero stock quantities and - on re-
quest — index entries without stock.
SAP EWM index tables: /scwm/
STOCK_IW01l, IW02, IWO03 and
_IW04

The index table entries are only de-
leted if this is allowed in Customiz-
ing. For more information, see Cus-
tomizing for SAP EWM under

|} SCM Basis > Logistics Inventory
Management Engine (LIME) > Basic
Settings > Index Tables and
Hierarchy > Determine Index

Tables 3.

Report /scwm/

R _REORG

HU WO PRINT

Not applicable

Periodicity analogous to archiving
periods of the warehouse tasks

Warehouse logistics processing: De-
letes SAP EWM-specific PPF action
data

Report /saparo/
DELETE PRODUCTS

Not applicable

Monthly

Master data: Deletes products with
deletion flag

Report /sapapo/
DELETE_LOCATIONS

Not applicable

Yearly

Master data: Deletes locations with
deletion flag

Report /scwm/
R EWM AUDIT DELET

E DATA

Not applicable

Monthly or yearly

Deletes data that is no longer re-
quired for audit purposes

Report /scMB/
ALEN ALERT DELETE

Not applicable

Weekly or monthly

Deletes alerts older than x days

Report /scwM/R_MS
RESULT DELETE

Not applicable

Depends on the usage of Measure-
ment Services

Labor Management (Analytics): De-
letes Measurement Service Results
(SAP Easy Access screen

| Extended Warehouse
Management > Settings >
Measurement Services > Periodic

Processing })

Report /scTM/
DELETE ROUTE

Not applicable

Monthly

Master data: Deletes routes with de-
letion flag
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Program Name/Task Task Scheduling Tool

Recommended Frequency

Detailed Description

Report /sctm/ Not applicable Monthly Master data: Deletes transportation

DELETE ZONE zones with deletion flag

Report /scTM/ Not applicable Yearly Freight order processing: Deletes

CLEANUP_ PPF the PPF actions without corre-
sponding business objects (actions
to publish the deletion of the ob-
jects)

Transaction /scwM/ Not applicable Determines and sets prices from

VALUATION SET SAP ERP

Report /scum/ Not applicable Transfers extracted data from qRCF-

R BW COLLECTIVE R Queue WMTB (warehouse task),

UN WMOB (warehouse order), WMBB
(storage bin), WMDB (delivery
item), or WMVB (Value Added Serv-
ice) to the Bl Delta Queue

Report /scwm/ Not applicable Posts differences (for example,

R WM ADJUST warehouse task differences) to the
SAP ERP system

Report /scum/ Not applicable Daily Completes outbound delivery order

R _PDO_COMPLETE items with zero quantity

Report /scwmM/ Not applicable Monthly or yearly Warehouse logistics processing: De-

R_REORG_EXCEPTION
_ SOLVED

letes the object-related history re-
cords of exception code processing

Scenario-Specific Scheduled Periodic Tasks

Required for Scenario(s)

Program Name/Task

Recommended Frequency

Description

Queue Alerting

Report /scwm/
R_QRFC_QUEUE_ ALERT

Every 30 - 120 minutes

Creates alert for failed gRFC
message

Queue Alerting

Report RSALERTPROC

Monthly

Deletes old alerts

Dock Appointment Schedul-
ing

Report /scwm/
R_DAS DELETE

Monthly

Deletes old DAS time slots
and loading appointments

If you also use report /scwM/
DSAPP_DES to delete loading
appointments (see below),
choose the Delete Only Time
Slots checkbox in this report
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Required for Scenario(s)

Program Name/Task

Recommended Frequency

Description

Dock Appointment Schedul-  Report /scwM/DSAPP DES Monthly or yearly Data destruction program for

ing loading appointments

Proof of Delivery Report /scwM/RPOD IMP Daily Imports proof-of-delivery
Option Create (POD) data from SAP ERP

Proof of Delivery Report /scwM/RPOD IMP Monthly Deletes POD data

Option Delete

Cartonization Planning

Transaction /sCWM/CAPDEL

Depends on how often plan-
ned shipping HUs are used in
the outbound process.

Weekly, monthly or yearly.

For goods issue posted out-
bound delivery orders the
planned shipping can be de-
leted. Alternatively, you can
also delete PSHUs before
wave creation with the re-
port /scwm/
R_WAVE PLAN BACKGROUND
. To do so, select the Delete
Planned Shipping HUs check-
box of the report.

Labor Management

Report /scwM/R_MS
RESULT DELETE

Depends on the usage of
Measurement Services

Labor Management (Analyt-
ics): Deletes Measurement
Service Results (SAP Easy

Access screen ||p Extended
Warehouse Management >
Settings > Measurement
Services > Periodic

Processing ])

Labor Management

Report /scwm/
R_REORG_LDP_ HIST

Depends on the amount of
data needed for Labor De-
mand Planning Forecast and
the DB growth

Deletes historical workload
data

Labor Management

Report /scwmM/
RLM EWL COMPLETE

Daily (hourly if Customizing
for asynchronous completion
is active)

Processes incomplete exe-
cuted workload records

Using BRFplus in EWM (La-
bor Management)

Report /scwm/
R LEAN TRACE DELETE

Daily, weekly or monthly, de-
pending on the use of
BRFplus and the size of the
warehouse

Deletes SAP EWM-specific
lean trace records

Labor Management with
Time and Attendance Data

Report /scwm/
R_TATT UPLOAD

Daily

Uploads time and attendance
data

26 PUBLIC

SAP Extended Warehouse Management 9.5 Operations Guide

Management of SAP EWM



Required for Scenario(s)

Program Name/Task

Recommended Frequency

Description

Labor Management with
Time and Attendance Data

Report /scwM/TATT DES

Monthly or yearly, depending
on the growth rate of the
TATT database table and re-
tention needs for TATT en-
tries

Deletes time and attendance
data

Transportation Integration
(ERP)

Report RBDMANTI2

Hourly

Processes IDocs which are
not yet posted

Transportation Management
in EWM

Report /scTM/
CLEANUP PPF

Yearly

Freight order processing: de-
letes the PPF actions without
corresponding business ob-
jects (actions to publish the
deletion of the objects)

Transit Warehouse

Report /scwm/
R REORG HU TW PPF

Monthly

HU processing in transit

warehouse: Deletes SAP
EWM-specific PPF action
data

Delayed completion of in-
bound deliveries

Report /scwmM/
R_DELETE DWM VARI

Daily

Deletes obsolete variants for
report /SCWM/
R _PRDI_ SET DWM

When you schedule the job,
ensure that the job to reor-
ganize the background jobs
(RSBTCDEL2) deleted the

corresponding job logs

Warehouse Billing

Report /scwm/

WB_SNAPSHOT DELETION

Monthly

Deletes obsolete snapshot
data

Warehouse Billing

Report /scwm/
WB_WBMR_DELETION

Yearly

Deletes obsolete request for
warehouse billing measure-
ment and specifications of
warehouse billing measure-
ment

Transit Warehouse

Report /scwm/
R REORG_HU TW PPF

Monthly

HU processing in transit

warehouse: Deletes SAP
EWM-specific PPF action
data
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Required for Scenario(s) Program Name/Task Recommended Frequency  Description

SAP Global Batch Traceabil-  Report /scwm/ Depends on the desired fre-  Transfers the events for han-
ity in SAP EWM GBT_R_EVENT TRANSFER quency and the number of dling units (HUs), which are
events that are created dur-  relevant for SAP Global Batch
ing a business day Traceability, from SAP EWM
to the configured receiver
system, which is SAP Global
Batch Traceability

The data transfer uses Web
Services runtime for service-
oriented architecture (SOA).
The communication is based
on the notification communi-
cation pattern.

SAP Global Batch Traceabil-  Report /scuwm/ Depends on the run fre- Deletes events from the
ity in SAP EWM GBT_R_EVENT DELETION quency of report /scwm/ EWM-GBT transfer database
GBT R EVENT TRANSFER table that have the status
Transmitted

4.5.2 Required Manual Periodic Tasks

This section describes all manual tasks required to run periodically to keep the application running smoothly
over time. A manual task needs a user to execute each task, as opposed to the scheduled tasks listed above
which can be automated using a task scheduler program. Such tasks may be required on component level and
are therefore relevant in each scenario that uses the component. Other tasks may be relevant for certain
business scenarios only. It is important that you monitor the successful execution of these tasks on a regular
basis.

Scenario-Specific Manual Tasks

Required for Scenario(s) Tool(s) Supporting this Task Recommended Frequency Description

Dock Appointment Schedul-  Web Dynpro Application / Depends on the usage of For the creation of time slots

ing SCWM/DSSLOT GEN time slots in Dock Appoint- in the graphical view of Dock
ment Scheduling (DAS) Appointment Scheduling
Weekly or monthly

46 Load Balancing

SAP EWM uses standard SAP NetWeaver functions for logon and load balancing.
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For more information, see SAP NetWeaver at http://help.sap.com/nw# under | Function-Oriented View »
Solution Life Cycle Management » SAP Business Continuity 3 and under | Technical Operations for SAP
NetWeaver 3.

4.7 Management of Outdated Technical Data

The deletion of technical data is included in Scheduled Periodic Tasks [page 22].

4.8 Scenario Administration Concept

SAP EWM uses standard SAP NetWeaver functions. There are no specifics for administration in SAP EWM
scenarios. The behavior of SAP EWM in different deployment options for starting and stopping the system is
described in Starting and Stopping [page 21].
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5 High Availability

SAP EWM uses standard SAP NetWeaver functions for high availability.

For more information about high availability, see SAP NetWeaver at http://help.sap.com/nw#& under
|+ Function-Oriented View » Solution Life Cycle Management » SAP Business Continuity 4.
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6 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components for SAP Extended
Warehouse Management (SAP EWM).

6.1 Transport and Change Management

For transport and change management issues, the procedures of SAP NetWeaver apply for SAP EWM. For
more information, see SAP NetWeaver at http://help.sap.com/nw# under [ Technical Operations for SAP
NetWeaver » Administration of Application Server ABAP » Change and Transport System

You can use SAP EWM with multiple clients. This is a useful option for test systems if you want to test different
warehouse-independent settings in parallel. For your production system, you must ensure that the sizing of
your system is sufficient for all warehouses on all clients.

If you are using multiple clients and Business Add-In (BAdI) filters in your SAP EWM system, you must ensure
that the filter values are disjunctive for all clients.

6.2 Development Requests and Development Release
Management

SAP EWM uses standard SAP NetWeaver procedures. For more information, see SAP NetWeaver at http:/
help.sap.com/nw# under |» Technical Operations for SAP NetWeaver

6.3 Support Packages and Patch Implementation

We recommend that you implement support package stacks (SP stacks), which are sets of support packages
and patches for the respective product version that must be used in the given combination. The technology for
applying support packages and patches will not change.
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For more information about the availability of SP stacks, see http:/support.sap.com/sp-stacks# .

Read the corresponding release and information notes (RIN) before you apply any support packages or
patches of the selected SP stack.

The RIN and support packages for SAP EWM are available at http:/support.sap.com/patches# . Use the
search function to find SAP EWM 9.5.

Use the maintenance planner (previously known as the Maintenance Optimizer) in SAP Solution Manager to
select, download, and install the required software layers, or software components and required support
packages. For more information, see the following:

® User guide for SAP Solution Manager’s maintenance planner at https://help.sap.com/viewer/p/
MAINTENANCE_PLANNER

e SAP Community Network at http://wiki.scn.sap.com/wiki/x/VIwgCw

For more information about implementing support packages as well as possible side effects, see http:/
support.sap.com/patches .

For more information about the tools necessary for implementing patches, see SAP NetWeaver at http:/
help.sap.com/nw# under |+ Technical Operations for SAP NetWeaver  Administration of Application Server
ABAP 1.

i Note

If you use SAP EWM with the deployment option SAP EWM as SAP NetWeaver Add-On, you can select the
zero downtime option of the Software Upgrade Manager (SUM). See SAP Notes 2163060#% and 2251678
& for details.
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7  Troubleshooting

For information about troubleshooting SAP NetWeaver, see SAP NetWeaver at http://help.sap.com/nw #
under |+ Technical Operations for SAP NetWeaver 3.
The following tools are available for troubleshooting SAP Extended Warehouse Management (SAP EWM):
e Application logs
For more information, see Trace and Log Files [page 9].

e \Where-used list
The where-used list informs you about where a product is used in SAP EWM. This enables you, for example,
to determine whether a product is still used in a document and to identify inconsistencies in the product

data. For more information, see SAP EWM at http://help.sap.com/ewm#& under |» SCM Basis » SCM
Basis Master Data » General Master Data Functions » Deleting Master Data » Where-Used List for Master
Data 3.
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8 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support
organization that seamlessly integrates your end users, internal support employees, partners, and SAP Active
Global Support specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure
to run your internal support organization efficiently.

8.1 Remote Support Setup

SAP support must be able to work remotely for highest efficiency and availability and, therefore, requires
remote access to all necessary support tools. For SAP Extended Warehouse Management (SAP EWM), the
standard SAP procedures for setting up remote support apply.

For information about remote support setup, see http://support.sap.com/remoteconnection#.

8.2 Problem Message Handover

To send problem messages or tickets to SAP, choose the appropriate component (or subcomponent) name
from the SAP component hierarchy:

Component Description

SCM EWM Extended Warehouse Management
SCM-EWM-ANA Analytics

SCM-EWM-ARC Archiving

SCM-EWM-AUT Authorization

SCM-EWM-CD Cross-Docking

SCM-EWM-CAP Cartonization Planning
SCM-EWM-DLP Delivery Processing
SCM-EWM-DAS Dock Appointment Scheduling
SCM-EWM-EH Exception Handling
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Component

Description

SCM-EWM-GM Goods Movements
SCM-EWM-IF Interfaces

SCM-EWM-LM Labor Management
SCM-EWM-MD Master Data
SCM-EWM-MFS Material Flow System
SCM-EWM-MON Monitoring

SCM-EWM-PI Physical Inventory
SCM-EWM-PMR Production Material Request
SCM-EWM-PRC Preconfigured Processes
SCM-EWM-PRN Printing

SCM-EWM-QM Quality Management
SCM-EWM-RF Radio Frequency Processing
SCM-EWM-RG Routing Guide
SCM-EWM-SR Shipping and Receiving
SCM-EWM-TM Transportation Management in EWM
SCM-EWM-UIF User Interface Framework
SCM-EWM-VAS Value Added Services
SCM-EWM-WAV Wave Management
SCM-EWM-WB Warehouse Billing
SCM-EWM-WC Work Center
SCM-EWM-WOP Warehouse Order Processing

For information about safeguarding, see http://service.sap.com/safeguarding .

- Recommendation

When you send a message to SAP for one of the SAP EWM components, always provide the warehouse
number together with the technical key (document number) in the description.
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If you want to use a predefined role for read-only access for remote support, you can use the role
SAP_RCA SAT DISP. Itis available in the STPI plug-in and is generated when a managed system is connected
to SAP Solution Manager.
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A Appendix

A.l Appendix

A.1.1 Related Guides

For more information about installation and configuration, see the Master Guide.

A.1.2 Related Information

The following table contains links to information related to the Application Operations Guide.

Content

Link

Master Guide, Installation Guide and Upgrade Guide

http://help.sap.com/ewm

Related SAP Notes

http://support.sap.com/notes#r

Released Platforms

http://support.sap.com/pam

Network Security

Security Guide at http://help.sap.com/ewm

Technical Infrastructure

http://help.sap.com/nw

SAP Solution Manager

http://help.sap.com/ewm
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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© 2019 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.

THE BEST RUN
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